- User Interface Reference
- Keyboard Shortcuts
Welcome to ConceptDraw MINDMAP v9 for Windows 1

Toolbar Tour 3

Quick Access ................................................................. 4
Help Menu ................................................................. 5
File .............................................................................. 6
  Import ......................................................................... 8
  Export ........................................................................ 9
  Print Preview ............................................................. 10
Home ............................................................................ 12
  Brainstorm .................................................................. 14
  Format .......................................................................... 15
    Format Topic ................................................................ 16
    Format Callouts ......................................................... 20
    Format Relationships .................................................. 23
    Format Drawing .......................................................... 25
Insert ............................................................................ 27
View .............................................................................. 29
Presentation ..................................................................... 31
Share ............................................................................. 33
  Tweet Topic .................................................................. 35
  Add to Evernote .......................................................... 38
  Skype Presentation ....................................................... 39
  Send to MS Outlook ...................................................... 42
  Send to MS OneNote ...................................................... 45
  Open in Project ............................................................. 48
Filters ............................................................................. 50
Input .............................................................................. 51
Output ............................................................................ 52
Dialogs .......................................................................... 56
  Map Theme Style ........................................................... 57
  Color ............................................................................. 58
  Font .............................................................................. 59
  Sort Topics .................................................................... 60
  Options ........................................................................ 61
  Margins and Spacing .................................................... 63
  Properties ..................................................................... 64
  Export to MS PowerPoint ............................................. 65
  Export to MS Word ......................................................... 67
  Export to Images .......................................................... 69
  Export to RTF ................................................................. 70

© 2018 CS Odessa corp.
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export to Text Outline</td>
<td>71</td>
</tr>
<tr>
<td>Export as Web page</td>
<td>72</td>
</tr>
<tr>
<td>Connect with Twitter Account</td>
<td>74</td>
</tr>
<tr>
<td>Note Exchange Settings</td>
<td>75</td>
</tr>
<tr>
<td>Floating Panels</td>
<td>76</td>
</tr>
<tr>
<td>Arrange Panel</td>
<td>77</td>
</tr>
<tr>
<td>Symbols Panel</td>
<td>82</td>
</tr>
<tr>
<td>Graphics Panel</td>
<td>83</td>
</tr>
<tr>
<td>Hypernote Panel</td>
<td>85</td>
</tr>
<tr>
<td>Topic Types Panel</td>
<td>87</td>
</tr>
<tr>
<td>Topic Data Panel</td>
<td>89</td>
</tr>
<tr>
<td>Page Navigator Panel</td>
<td>91</td>
</tr>
<tr>
<td>Context Menu</td>
<td>92</td>
</tr>
<tr>
<td>Main Idea Context Menu</td>
<td>93</td>
</tr>
<tr>
<td>Topic Context Menu</td>
<td>94</td>
</tr>
<tr>
<td>Callout Context Menu</td>
<td>95</td>
</tr>
<tr>
<td>Relationship Context Menu</td>
<td>96</td>
</tr>
<tr>
<td>Drawing Shape Context Menu</td>
<td>97</td>
</tr>
<tr>
<td>Keyboard Shortcuts and Mouse Actions</td>
<td>98</td>
</tr>
</tbody>
</table>
Welcome to ConceptDraw MINDMAP v9 for Windows

Welcome to ConceptDraw MINDMAP
Computer Systems Odessa Corporation introduces you ConceptDraw MINDMAP - a powerful application for creating clear and visual Mind Maps for Mac and PC platforms.

Visual Thinking and Mind Mapping
Your Benefits
ConceptDraw Maintenance Assurance
Technical Support

Visual Thinking and Mind Mapping
It is known that visual thinking is inherent and natural to human mind. That is why visual form is most effective for representing information of any sort: it provides clarity, facilitates perception and understanding, gives a general view which is especially important in planning, developing ideas and projects, studying complex material. Information in visual form is easier to remember, and effective to present and explain to others.

Mind Mapping is a technique for representing and organizing ideas and items of information in a visual form. It helps you express your ideas in an easy way and organize them one after another in the form of a tree. It reflects the natural mode of thinking:
1) the main topic is put in the center;
2) then it is developed in the topics;
3) which in their turn are further developed in the subtopics which are put as sub-topics.

In the sub-topics, the topic is divided into parts, specified and presented in more detail. Subtopics can also hold additional information, or some ideas formed by association. Moreover, there are conventional graphical signs which can be added to the topics to evaluate the ideas or show the attributes of the topics. This results in a clear graphical representation of the ideas (or items of information) and relations between them in the form of a Mind Map. In the Mind Map you can also reinforce the ideas by using graphics, colors, figures and connections. The main advantage of Mind Maps, in comparison with ordinary lists and tables, is that a Mind Map provides a view of the whole. You see the entire structure of the topic presented - this leads to better understanding, and you can discover new ideas and approaches.

ConceptDraw MINDMAP is a powerful and easy-to-use tool for Mind Mapping. Its advanced features will help you quickly organize your ideas and structure your concepts, plans, daily work, learning material and other information. This application makes work and learning more effective and facilitates idea generation.

Your Benefits
ConceptDraw MINDMAP combines the power of two technologies:
- the Mind Mapping technique which helps dividing the problem into several simpler parts and solve them effectively;
- and the ConceptDraw technology which helps you visualize the thinking process, and makes it easy to modify and develop the ideas and share them with others easily via the Internet.

ConceptDraw MINDMAP is effective and helpful in any tasks when you need to:
- generate, organize and evaluate ideas;
- structure some information;
- put some concepts in a clear and attractive way to persuade others.
So it proves helpful as a powerful and easy-to-use tool for many purposes:
  o Planning
  o Teaching
  o Organizing
  o Note-taking
  o Outlining
  o Brainstorming
  o Decision-making
  o Presentations
  o Summaries
  o Project management

With ConceptDraw MINDMAP you can:
  o present processes, ideas, complicated relationships graphically - in the printed way or on the Internet;
  o visualize and analyze different factors in daily business decisions;
  o facilitate idea generation in the most creative mode of thinking - you allow ideas to flow freely before starting to organize them;
  o present your learning material in a logical and structured way to understand and remember it better;
  o create clear, appealing and persuasive Mind Maps which make your work or studies more effective;
  o visualize and structure the plans or ideas to help others working on a project understand it and to encourage creativity of their own.

ConceptDraw Maintenance Assurance
We have developed an innovative maintenance program that makes sure you stay up to date. At the time of your buy a ConceptDraw product, you are able to purchase ConceptDraw Maintenance Assurance.

Technical Support
We offer unlimited free technical support for our users.
To send us a problem report or feature request, submit the ticket form in the Help Desk section on our Web site.
Replies are normally sent within one business day. We are always happy to answer your questions and hear your feedback.
The ConceptDraw MINDMAP v9 toolbar provides quick access to functions that are commonly performed within the program.

Quick Access
File
Home
View
Presentation
Share
Format
Filters
Help
Quick Access

Quick Access menu facilitates access to the most frequently used functions. It is located at the top of Toolbar.

- New: Start a new mind map
- Open: Open an existing map
- Save: Save the current document
- Undo: Undo the last action
- Redo: Redo the last undone action
- Quick Print: Send the map directly to the default printer without making changes
- Print Preview: Preview and make changes to pages before printing
**Help Menu**

- **ConceptDraw MINDMAP Help:** Calls the ConceptDraw MINDMAP Help System. It opens in a separate window where you can see a number of articles containing information on how to use the product. You can read or print the articles, search them for the needed information.

- **Keyboard Shortcuts:** Calls the ConceptDraw MINDMAP ready-to-print list of the keyboard shortcuts in pdf format.

- **Getting Started PDF:** Opens the Getting Started guide in the PDF format.

- **Online Help Desk:** Allows you to ask a question to ConceptDraw MINDMAP Support Team.

- **About:** Opens the About window, where you can see the information about the application version and developers.
**File**

### New
Create a new document

### Open...
Open an existing file

### Recent Documents
- Lean Manufacturing Problem Solving.cdmz
  C:\Users\Anna\Google Drive\Samples
- Project sample.cdmz
  C:\Users\Anna\Google Drive\Samples
- Startup Project.cdmz
  C:\Users\Anna\Google Drive\Samples

### Save
Save the currently opened file

### Save As
Save a copy of the document

### Import
Create map file (cdmz) from other file types

### Export
Save map file (cdmz) as other file type

### Print
Preview and print the document

### Send
Send a copy of current document in an email message as an attachment

### Close
Close the currently opened document

### Properties
Open the Document Properties dialog

### Options
Open Options dialog
Save as

Save a copy of the document.

- Document: Save as ConceptDraw MINDMAP document (cdmz)
- Template: Save as ConceptDraw MINDMAP template (cdmtz)
- Presentation: Save as ConceptDraw MINDMAP document (cdmz). File opens as a presentation using slides from Slide Navigator.
- Brainstorm: Save as ConceptDraw MINDMAP template (cdmtz). File opens as a Brainstorming session
- Save as ConceptDraw PROJECT: Save as ConceptDraw PROJECT document (cdpz)

Print

Print ConceptDraw MINDMAP document.

- Print: Send the map directly to the default printer without making changes
- Print Preview: Open Print Preview tab
- Map: Preview and print the current mind map
- Outline: Preview and print the current mind map as text outline
- Notes: Preview and print text notes to the topics of the current map

Send

Send a copy of current ConceptDraw MINDMAP document in an email message as an attachment.

- E-mail: Send the current mind map file via email as an attachment
- E-mail Presentation: Send the current mind map file via email as an attachment. File will be automatically opened in the presentation mode
Import

The **Import** section provides the access to ConceptDraw MINDMAP import opportunities:

- **FreeMind** - Open a XMind file (XIND)
- **Mindjet MindManager** - Open a MindManager file (MMAP)
- **MS Excel** - Create a mind map from MS Excel document (XLSX)
- **MS PowerPoint** - Create a mind map from PowerPoint presentation (PPTX)
- **MS Project** - Create a mind map from MS Project document (MPP)
- **MS Word** - Create a mind map from MS Word document (DOCX)
- **OPML** - Create a mind map from Outline Processor Markup Language file (OPML)
- **Text Indented Outline** - Create a mind map from indented or numerated Text Outline (TXT)
- **Text Numerated Outline** - Create a mind map from indented or numerated Text Outline (TXT)
- **XMind** - Open a FreeMind file (MM)
Export

The **Export** section provides the access to ConceptDraw MINDMAP export opportunities:

- **Adobe PDF**: Save a mind map as a Portable Document Format file (PDF)
- **Mindjet MindManager**: Save a mind map as a MindManager file (MMAP)
- **MS PowerPoint**: Save a map as a [MS PowerPoint](#) presentation (PPTX)
- **MS Project**: Save a mind map as a MS Project file (XML)
- **MS Word**: Save a mind map as a [MS Word](#) file (DOCX)
- **OPML**: Save a mind map as an Outline Processor Markup Language file (OPML)
- **Images**: Save a mind map as a graphic file (BMP, JPG, GIF, TIFF, PNG)
- **RTF**: Save a mind map as a Rich Text Format file (RTF)
- **Text Outline**: Save a mind map as text outline file (TXT)
- **Web Page Map View**: Save a mind map as a [Web-page](#) (HTML)
- **Web Page Outline View**: Save an outline of the mind map as a [Web-page](#) (HTML)
Print Preview

Preview and make changes to pages before printing

Print

- **Print**: Print the current document.
- **Printer**: Choose printer and printer properties.

Page Setup

- **All Pages** - print the entire document.
- **Current** - print the current page.
- **Range** - type page numbers or page ranges you want to print.
- **Copies** - type number of copies.

- **Size**: Choose the page size from the drop-down list.

- **Orientation**: Switch the pages between portrait and landscape layout. Choose "The Best" to automatically set orientation, which is fit to the current map size.
Margins: Set the margins for the current document.

Actual Scale - Print the document in zoom 100% of the actual size.
Specific Scale - Set the scale percentages of the actual size.
Fit to - set the number of pages, your map will be split.

Page Content

Select exactly the type of document you want to print

Map: Printing the map view

Outline: Printing the outline view

Notes: Printing Notes

Specify some visible options of your printed output

Preview

Previous page/Next Page: Navigate between pages on page preview

Zoom in: Zoom in the document print preview

Zoom out: Zoom out the document print preview

Fit Page: Zoom the document so that entire document fits one page

Close: Close the Print Preview window
Home

Clipboard
Font
Insert
Map Theme
Arrange
Editing

Clipboard

Paste
Cut
Copy
Format painter

Paste contents from the Clipboard.
Cut selection and put it into Clipboard.
Copy the selection and put it into the Clipboard.
Copy formatting from one place and apply it to another.
Double-click this button to apply the same formatting to other places on the map.

Font

Select the topic that contains the text that you want to format. Click the font formatting buttons that you want to use.

Insert

Brainstorm: Switch the Brainstorming mode.

Topic: Add topic to the same level as the selected one.
If no topic is selected, the topic is added to the Main Idea topic. If selected topic is disconnected with others, a new disconnected topic is added below.

Subtopic: Add topic on the next level to selected one.
If no topic is selected, the topic is added to the Main Idea topic.

Relationship: Insert Relationships to indicate logical dependences between topics (usually project tasks or milestones): Start-to-Start, Start-to-Finish, Finish-to-Start, or Finish-to-Finish.
Insert Relationships by dragging mouse between related topics. Relationships have different styles.

Attach File: Attach a file to selected topic.
Map Theme

- **Map Theme** changing: Change the style of the entire map. You can quickly change Map Theme to any of pre-installed themes. You can open any another Map Theme from your computer and apply to your map. You can create your own theme and save it as a new one.

- **Background**: Change Background color.

- **Map Theme button**: Open Map Theme Attributes dialog.

Arrange

- **Arrange branch**: Arrange selected branches of the mind map.

- **Auto-arrange**: On/Off the Auto-arrange mode. The newly created mind maps has the Auto-arrange mod active on default.

- **Arrange**: Activate the Arrange panel for the object selected.

Editing

- **Find**: Find text in the map content.

- **Spelling**: Check the spelling and grammar of text in the map and map notes.

- **Smart Enter**: Smart Enter mode. This option allows entering new topic quickly.
  - **ON**: Enables using the "Enter" key to complete the topic editing and add the sibling topic at once.
  - **OFF**: Enables using the "Enter" key just to complete the topic editing.
**Brainstorm**

Brainstorming in ConceptDraw MINDMAP is easy thanks to the special Brainstorming mode. Click the Brainstorm button on the Home tab to activate the Brainstorm panel.

ConceptDraw MINDMAP provides you with different brainstorming options. Brainstorm panel allows you to specify the topic of the brainstorming session and record the ideas as a list. The Brainstorm mode allows to generate as much as possible ideas related to a specific theme for a limited amount of time.

1. Start the countdown / Pause the countdown.

2. Enter hours, minutes and seconds.

3. Enter here the theme of brainstorm session. Then press the Enter key.

4. Enter here an idea. Then press Enter key or click the Add Idea button.

5. Exit Brainstorm mode and start editing map.
Format

ConceptDraw MINDMAP provides a variety of style and formatting options for your mind maps, that let you make them more informative without interfering with its readability. You can completely customize the style of your mind maps, including the style of topics, callouts, relationships and even format of drawn shapes.

**Topic formatting tools**

**Callout formatting tools**

**Relationship formatting tools**

**Drawn shape formatting tools**
**Format Topic**

To access the topic format tab, select a topic and Format tab, or use [context menu](#).

---

**Format Topic Style**

- **Fill**: Change the fill color of selected topic. Also change gradient type and background color, as well as pattern ornament.

- **Line**: Change the color of the selected topic's outline and branch connection line. Also change line style and weight.

- **Tail Line**: Change the color of the selected topic's branch connection line. Also change line style and weight.

- **Shape**: Change the Shape of selected topics, such as Rectangle, Circle, Hexagon, etc. You can insert any image as topic background.

- **Apply to Current Level**: Apply the Style changes to all topics on the current level. The changes will be set as default style for the given level of the current map.

- **Clear Style**: Restore the latest default style of selected topics.
Format Topic Shape

Change the shape of selected topics, such as Rectangle, Circle, Hexagon, etc. You can insert any image as topic background.

- **Automatic**: Change the shape of selected topics to the shape that is set as default for current Map Theme.

- **None**: No topic shape

- **Line**: Line on the bottom border of a topic

- **Squirrel**

- **Rectangle**

- **Rounded Rectangle**: Default topic shape in the ConceptDraw MINDMAP blank document.

- **Hexagon**

- **Octagon**

- **Circle**

- **Oval**

- **Custom Image**: Insert any image as topic background.
Format Topic Font

Select the topic that contains the text that you want to format. Click the font formatting buttons that you want to use. Use the button at the right bottom corner of the group to open Font dialog.

Layout

Graphics Alignment controls allow changing position of an image within the topic.

- **Left (top)** - Align image at the top left corner of the topic.
- **Left (center)** - Center image vertically and align it to the left side of the topic.
- **Left (bottom)** - Align image to the bottom left corner of the topic.
- **Right (top)** - Align image at the top right corner of the topic.
- **Right (center)** - Center image vertically and align it to the right side of the topic.
- **Right (bottom)** - Align image to the bottom right corner of the topic.
- **Top (left)** - Align image at the top left corner of the topic.
- **Top (center)** - Center image and align it to the top of the topic.
- **Top (right)** - Align image at the top right corner of the topic.
- **Bottom (left)** - Align image to the bottom left corner of the topic.
- **Bottom (center)** - Center image and align it to the bottom of the topic.
- **Bottom (right)** - Align image to the bottom right corner of the topic.

The button at the right bottom corner of the group opens the Margins and Spacing dialog.
Format Subtopics

**Tail:** Change the shape of the connecting lines between the topic and its subtopics.

- No Line
- Straight
- Arc
- Curve
- Elbow
- Rounded Elbow
- Sheared Elbow
- Angle

**Anchor:** Change the placement of the beginning point of the branch lines.

The button at the right bottom corner of the group opens the [Margins and Spacing](#) dialog.
Format Callouts

To access the topic format tab, select a callout and Format tab or use context menu.

Format Callout Style
Format Callout Font
Format Callout Layout

Format Callout Style

Fill: Change the fill color of selected callout. Also change gradient type and background color, as well as pattern.

Line: Change the color of selected callout’s outline. Also change line style and weight.

Shape: Change the shape of selected callout, such as Cloud, Rectangle, Oval, etc. You can also insert any image as a topic background.

Apply to All: Apply the Style changes to all callouts on the current map. The changes will be set as default style for all callouts of the current map.

Clear Style: Restore the latest default style of selected callouts.
Format Callout Shape

- Change the shape of selected callout, such as Cloud, Rectangle, Oval, etc. You can also insert any image as a callout background.

- Change the shape of selected callout to the shape that is set as default for current Map Theme.

- No callout shape and outline.

- Line
  - Rectangle
  - Rounded Rectangle
  - Oval
  - Bubble

- Highlight text of the callout.

- Cloudy

Select Image - Insert any image as topic background.
Format Callout Font

Select the callout that contains the text that you want to format. Click the font formatting buttons that you want to use. Use the button at the right bottom corner of the group to open Font dialog.

Format Callout Layout

Graphics Alignment controls allow changing position of an image within the callout.

- **Left (top)** - Align image at the top left corner of the callout.
- **Left (center)** - Center image vertically and align it to the left side of the callout.
- **Left (bottom)** - Align image to the bottom left corner of the callout.
- **Right (top)** - Align image at the top right corner of the callout.
- **Right (center)** - Center image vertically and align it to the right side of the callout.
- **Right (bottom)** - Align image to the bottom right corner of the callout.
- **Top (left)** - Align image at the top left corner of the callout.
- **Top (center)** - Center image and align it to the top of the callout.
- **Top (right)** - Align image at the top right corner of the callout.
- **Bottom (left)** - Align image to the bottom left corner of the callout.
- **Bottom (center)** - Center image and align it to the bottom of the callout.
- **Bottom (right)** - Align image to the bottom right corner of the callout.

The button at the right bottom corner of the group opens the Margins and Spacing dialog.
Format Relationships

To access the topic format tab, select a relationship and Format tab or use context menu.

Format Relationship Type
Format Relationship Style
Format Relationship Ordering
Insert Relationship

Format Relationship Type

- **General:** Change the selected relationship to default type. If you have changed the style of Endpoint's, you can save it as General type by clicking **Apply to All** button.

- **Finish to Start:** Change the selected relationship to Finish-to-Start.

- **Start to Start:** Change the selected relationship to Start-to-Start.

- **Start to Finish:** Change the selected relationship to Start-to-Finish.

- **Finish to Finish:** Change the selected relationship to Finish-to-Finish.

Format Relationship Style

- **Line:** Change the color, weight and style.

- **Endpoints:** Change the shapes on the end points of a relationship.

- **Apply to All:** Apply the Style changes to all Styles relationships and General Type relationships. The changes will be set as General Type for all relationships on the current map.

- **Clear Style:** Restore the latest default style of relationships.
Format Relationship Ordering

- Make Bottom Most - Send the selected relationship behind all other objects.
- Step Back - Send the selected relationship one step toward the back.
- Step Front - Bring the selected relationship one step closer to the front.
- Make Top Most - Bring the selected relationship in front of all other objects, so that no part of it is hidden behind other objects.

Insert Relationship

Insert Relationships to indicate logical dependences between topics (usually project tasks or milestones): Start-to-Start, Start-to-Finish, Finish-to-Start, or Finish-to-Finish).

Insert Relationships by dragging mouse between related topics. Relationships have different styles.

- Insert Relationship - Insert Relationships to indicate logical dependences between topics (usually project tasks or milestones): Start-to-Start, Start-to-Finish, Finish-to-Start, or Finish-to-Finish).
- Insert Relationships by dragging mouse between related topics. Relationships have different styles.

- General Relationship - Insert relationship of default type.
- Start to Start Relationship - Insert Relationship to indicate Start-to-Start dependency between topics.
- Start to Finish Relationship - Insert Relationship to indicate Start-to-Finish dependency between topics.
- Finish to Start Relationship - Insert Relationship to indicate Finish-to-Start dependency between topics.
- Finish to Finish Relationship - Insert Relationship to indicate Finish-to-Finish dependency between topics.
Format Drawing

To access the topic format tab, select a shape and Format tab or use context menu.

Format Drawing Style

Fill:
Change the fill color of selected topic. Also change gradient type and background color, as well as pattern.

Line:
Change the shape line color, weight and style.

End points:
Change line ends.

Format Drawing Ordering

Back: Send the selected shape behind all other objects.

Front: Send the selected shape one step toward the back.

Backward: Bring the selected shape one step closer to the front.

Forward: Bring the selected shape in front of all other objects, so that no part of it is hidden behind other objects.
Insert Drawing

- **Insert Rectangle** - Click in the upper left corner of where you want to place your rectangle and drag to the lower right corner to define the rectangle.
  
  To draw a square, hold the Shift key down while dragging down and across the screen.

- **Insert Ellipse** - Click in the upper left corner of where you want to place your ellipse and Drag to the lower right corner to define the ellipse.
  
  To draw a circle, hold the Shift key down while dragging down and across the screen.

- **Insert line** - Click in the where you want to place your line and drag to the selected endpoint. To constrain the line angle to a multiple of 45 degrees, hold down Shift key while dragging down.

- **Insert Spline** - Click in the where you want to place your spline and drag to the selected endpoint. The path of mouse cursor will define the form of your spline.

Select text or objects in the mind map.
Insert

**Topic Content**

**Position**

**Ordering**

**Page**: Add new page. The new page will appear at the end of Page Navigator.

**Topic**: Add to the same level as the selected one. If no topic is selected, the topic is added to the Main Idea topic. If selected topic is disconnected with others, a new disconnected topic is added below.

**Subtopic**: Add topic on the next level to selected one. If no topic is selected, the topic is added to the Main Idea topic.

**Callout**: Add a to selected topic.

**Relationship**: Insert to indicate logical dependence between topics (usually project tasks or milestones): Start-to-Start, Start-to-Finish, Finish-to-Start, or Finish-to-Finish). Insert Relationships by dragging mouse between related topics. Relationships have different styles.

**Drawing**: Draw ready-made shapes, such as Rectangle, Ellipse, Line, Spline. Draw objects on the empty space of map using mouse. Hold down the "Shift" key while drawing to make Square, Circle or Line at an angle that is multiple to 45 degrees (0,45,90…).

**Topic Content**

**Attach File**: Attach a file to selected topic

**Symbols**: Insert Symbols into selected topic.

Use Symbols for visual representation and accenting topic content.

**Image from Graphics**: Insert the library or from file.

**Hypernote**: Create a link to Topics, Callouts, Pages, Documents, Web pages, Email address. Hyperlink can be inserted into Topic or Callout in your document. The Hyperlink can be easily added and edited within a floating dialog.

**Topic Types**: Assign Type to a Topic.

The can be easily assigned and edited within a floating dialog.

**Topic Data**: Manage a assigned to specific Topic Type.
Position

- **Send to New Page** - Create a copy of selected topic on a blank page and move there a copy of the topic and all related subtopics. The initial topic and its copy will be automatically hyperlinked.
- **Indent** - Moves the topic to a lower level in the hierarchy.
- **Outdent** - Moves the topic to a higher level in the hierarchy.
- **Move to Next Position** - Moves the topic to the next position (based on the order the map is created).
- **Move to Previous Position** - Moves the topic to the previous position (based on the order the map is created).

Ordering

- **Auto Numeration** - Number topics in order.
  - Clockwise from top is set by default
- **Order** - Set order for Auto Numeration of topics: clockwise or radial:
  - Clockwise From Top
  - Clockwise From Horizontal (3 o’clock)
  - Counterclockwise From Top
  - Counterclockwise From Horizontal (9 o’clock)
  - Down Both Sides - Right First
  - Down Both Sides - Left First

- **Sort Topics** - Sort selected topics by priority levels.
View

Document View

Navigation

Levels

Panels and Windows

Document View

**Full Screen:** To use maximum screen size you can use the Full Screen Mode. All toolbars, dialogs and even the MS Windows task bar will be hidden. The program window will have scrollbars and page navigator letting you navigate the document in the bottom part of the window.

**Map Only:** View a document as a mind map

**Outline Only:** View a document as an outline

**Map & Outline:** View a document as an outline and a mind map simultaneously.

Navigation

**Page navigator:** Show/Hide Page Navigator

**Previous Page:** View the previous page of your document

**Next Page:** View the next page of your document

**Fit Map:** Zoom the page so that the entire document fits in the window

**Fit Selection:** Zoom the page so that the selected objects fit in the window

**Zoom In:** Zoom in on the document

**Zoom Out:** Zoom out of the document

**Zoom Level:** Choose a standard level within the 25% - 400% range, or set "Fit Selection" or "Fit Map".

**Zoom Box:** Zoom the map area so that currently selected topics fills the entire window. This can help you focus on specific map details.

**Hand Scroll:** Activates the Scroll Hand tool that allows one to easily move the page
Levels

- **Show All**: Display all subtopics of selected topic.
  
  If no topic is selected, the entire map will be displayed.

- **Collapse**: Collapse all associated subtopics of a selected topic.
  
  If no topic is selected, entire map will be collapsed up to Main Idea.

- **Expand**: Display subtopics of selected topic except subtopics that were collapsed. If no topic is selected, the entire map will be displayed except subtopics that were collapsed.

- **Level 1-3**: Display Topics by levels

Panels and Windows

- **Windows** - Switch to a different window that is currently open.

- **Panels** - Open/Clos floating dialogs and Navigators. Use Floating dialogs to create and edit map content
Presentation

Mind Map Presentation
Create Slide
Slide Navigation
Export Presentation
Skype Presentation

Mind Map Presentation

- **Start Presentation** - Show full-screen slide presentation for this map, using slides from Slide Navigator.
  - If there are no slides in Slide Navigator, default presentation will be created from first-level topics and their subtopics.
  - Click at the bottom of screen to access the presentation control panel.

- **Create Default Presentation** - Create default set of slides for presenting the current mind map.
  - Slides will be created from first-level topics and their subtopics.
  - You can preview slides using Slide Navigator.

Create Slide

- **Set to Visible** - Create slide from visible objects.

- **Set to Selected** - Create Slide from selected topics

- **Set to Selected with Subtopics** - Create slide from selected topics with subtopics

Slide Navigation

- **Slide Navigator** - Show/Hide Slide Navigator

- **Previous Slide** - Show previous slide

- **Next Slide** - Show next slide
Export Presentation

- **Images** - Save presentation in graphic format
- **MS Power Point** - Save presentation as Power Point file
- **Send Via E-mail** - Send the current mind map file via email as an attachment. File will be automatically opened in the presentation mode.
- **Skype** - Show a slide-show presentation during a conference call through Skype

Skype Presentation

- **Show Presentation** - Display your Mind Map Presentation to participants of the current conference call in Skype.
- **Watch Presentation** - See a Mind Map Presentation, for participants of the current conference call in Skype.
- **Presentation History** - Open the list of all viewed presentations open any of the presentations viewed via Skype
Share

Presentation

Images: Save presentation in graphic format

MS Power Point: Save presentation as MS Power Point file.

Send Via E-mail: Send a copy of the mind map via e-mail as attachment. File opens as in the presentation mode, using slides from Slide Navigator.

Skype Presentation: View or display a slide-show presentation during a conference call in Skype. Skype Presentation solution is required

ConceptDraw Office

Open in Project: Opens current document with ConceptDraw PROJECT, having closed it in ConceptDraw MINDMAP.

Sharing

Send to Evernote: Publish content from ConceptDraw MINDMAP to your Evernote account. Note Exchange solution is required.

Send to MS OneNote: Publish content from ConceptDraw MINDMAP to your MS OneNote notebook

Send to MS Outlook: Create a message in MS Outlook, or task containing information from selected topics.

Tweet Topic: Post the Tweet to your profile.

Exports

Adobe PDF: Save a mind map as a Portable Document Format file (PDF)

Mindjet MindManager: Save a mind map as a MindManager file (MMAP)

MS Project: Save a mind map as a MS Project file (XML)

MS Word: Save a mind map as a MS Word file (DOCX)

OPML: Save a mind map as an Outline Processor Markup Language file (OPML)

RTF: Save a mind map as a Rich Text Format file (RTF)

Text Outline: Save a mind map as text outline file (TXT),
Web Page Map View: Save a mind map as a Web-page (HTML)

Web Page Outline View: Save an outline of the mind map as a Web-page (HTML)
ConceptDraw MINDMAP allows you to post content to your account on Twitter from the mind map directly:

- **Tweet Topic** - Tweet the topic content, including hyperlinks and embedded picture
- **Tweet Map** - Tweet the entire mind map as picture;
- **Tweet Screen** - Tweet the part of map currently visible on screen;

**My Gallery**
Opens your Internet Browser on the gallery of your tweeted images

**Twitter**
Opens your Internet Browser on http://twitter.com

**Sign in/ Sign out**
Log in/log out to your Twitter account.

When posting your first Tweet from ConceptDraw MINDMAP press "Sign In" on the context menu of Tweet Topic button and connect application with your Twitter account.
Share with Twitter

You can tweet the selected topics. You can preview text and number of characters using Tweet Topic window.

Check the Mark Topic option if you want to mark the topic, you have tweeted, on your mind map.

Tweet Map

You can tweet the entire mind map. The Tweet Map window shows you the name of your mind map and number of characters.

You can preview the mind map from your Twitter account.
Tweet Screen

You can tweet the visible part of your mind map. The Tweet Screen window shows you the name of your mind map and number of characters.

You can preview the screenshot of your mind map from your Twitter account.
ConceptDraw MINDMAP allows you to publish content to your Evernote account from mind map directly.
ConceptDraw MINDMAP allows you to share a presentation slide-show during Skype conversation.

Show Presentation
Watch Presentation
Run Skype Presentation Wizard. Follow the wizard's steps to display your Mind Map Presentation to participants of the current conference call in Skype.
Run Skype Presentation Wizard. Follow the steps below to see a Mind Map Presentation, for participants of the current conference call in Skype.
Integration capabilities between ConceptDraw MINDMAP and MS Outlook enable conversion of mind map topics that have Appointment, Email, or Task type into MS Outlook message or task depending on **Topic Type**.

**Send to Outlook**

**Task**

Selected topics of the Task type will be sent to MS Outlook as tasks.

**Appointment**

Selected topics of the Appointment type will be converted to appointments in the MS Outlook calendar.
Selected topics of the Email type will be converted to MS Outlook message.
Using the following commands from the drop-down list, you can send topics of Task type to the MS Outlook To Do List. Be note, that these commands does not perform any action for the topics of e-mail type.

- **Current Page Tasks**: The topics of the Task type in the current page of your mind map will be converted into Tasks in the Outlook To Do List.
- **Current Tasks**: The topics of the Task type in the current page having less than 100% complete will be converted into Tasks in the Outlook To Do List.
- **All Tasks**: The topics of the Task type from all pages of your multipage mind map will be converted into Tasks in the Outlook To Do List.
- **Next Week’s Tasks**: The topics of the Task type in the current page scheduled for next week will be converted into Tasks in the Outlook To Do List.
Send to MS OneNote

ConceptDraw MINDMAP allows you to publish content to your MS OneNote notebook from a mind map directly.

When publishing first mind map from ConceptDraw MINDMAP to OneNote notebook press "Sign In" on the drop-down menu of MS OneNote button and connect to your OneNote account.

Send Text: You will have an outline of the selected topic or branch added to your OneNote notebook.

Marketing

1. Marketing
   1.1 Estimate market and make more exact marketing message
   1.2 Design and order final package
   1.3 Create press releases
   1.4 Create product specification materials
   1.5 Create marketing presentations
   1.6 Update product forecasts based on market feedback and analysis
   1.7 Update launch plan based on forecast

>>Link: http://www.stat.com
**Send Map**: You will have a note, containing a mind map text outline and preview image, added to your OneNote notebook.
**Send Document:** You will have a note, containing a mind map text outline, preview image and a ready-to-download source ConceptDraw MINDMAP file (CDMZ), added to your OneNote notebook.

- **Sales Plan**
  - 1. Sales Plan
  - 1.1 Existing Customer Business Strategies and Tactics
    - 1.1.1 Create a touch-point program.
    - 1.1.2 Prospect within my existing customer base.
  - 1.2 Don't forget to calculate your ratio!
  - 1.3 Obtain referrals from all my new customers.
  - 1.4 New Business Acquisition Strategies and Tactics
    - 1.4.1 Exceed my quota.
    - 1.4.2 Increase awareness in the marketplace of my products, services and solutions.
    - 1.4.3 Increase awareness in the community of my products, services and solutions.

- **Sales Plan**
  - Exceed my quota.
  - Increase awareness in the marketplace of my products, services and solutions.
  - Create a touch-point program.
  - Prospect within my existing customer base.
  - Obtain referrals from all my new customers.
The compatibility between ConceptDraw products allows you to migrate your documents from MINDMAP to PROJECT and vice versa. You can generate a project schedule from your mind map. Project file will be created from topics of Project Management type, which contain all project information. Notes will be opened as Notes to topics. Multiple hyperlinks will be also preserved in the Hypernote panel.

File opened in ConceptDraw MINDMAP:
The same file opened in ConceptDraw PROJECT
Filters

You can search and filter your currently opened mind map by keywords. The program allows you to filter topics, Notes and symbols including topic type symbols. The Filter button is used for this. Enter your keywords into the search box. The search results will be highlighted.

Click the filter button to turn on the filter.
**Input**

To access the Input tab, you need to uncheck the "Hide/Show Input and output" option in the Options dialog.

ConceptDraw MINDMAP supports inputting external data into a map with one click. Data comes in a variety of formats. You are able to input your data from many different file formats.

- **Open** - Open an existing file
- **Recent** - Open one of the recently opened files

Browse the list of activities and choose template, you need to start your work with ConceptDraw MINDMAP.

Create your favorite Inputs using context menu
**Output**

To access the Output tab, you need to uncheck the "Hide/Show Input and output" option in the Options dialog.

ConceptDraw MINDMAP offers a variety of outputs, making it easy to share map content in the appropriate format. Creating output is simple; just one click allows you to output to other applications, such as Microsoft PowerPoint and Word, as well as ConceptDraw PROJECT and ConceptDraw PRO. You can generate text and tables that are pertinent to your work.

Browse the list of activities and choose the type of output

Create your favorite Inputs using context menu
The output capability of ConceptDraw MINDMAP unlocks the information in your maps to build various kinds of documents.

**Presentations**

Open styled presentation in ConceptDraw PRO with illustrations and motes from mind map. You can choose the style of presentation from preview. You can create Slide Presentation for your mind map, using slides from Slide Navigator. You can save a map as MS PowerPoint presentation.

**Project Management Diagrams**

- **Open in PROJECT** - Opens current document with ConceptDraw PROJECT, having closed it in ConceptDraw MINDMAP.
- **Create Project** - Opens ConceptDraw PROJECT and creates a new project file that contains project information from selected mind map topics. If no topics are selected, the new project will be created from active map page.
- **Fishbone** - Creates a Fishbone diagram from your map. Diagram will be opened in ConceptDraw PRO. The Main Idea and Level 1 topics will create a "head" and "bones". The next levels topics creates additional text fields.
- **OrgChart** - Creates an Organizational Chart diagram from your map. Diagram will be opened in ConceptDraw PRO. You can create either single page or multiple page diagrams.
- **Gantt Chart** - Create Gantt chart from your map. Diagram will be opened in ConceptDraw PRO. Gantt Chart will contain Level1 and Level2 topics from active page.
- **PERT Chart** - Project Evaluation and Review Technique Chart Diagram. Create a PERT diagram from your map. Diagram will be opened in ConceptDraw PRO.
- **WBS** - Creates a Work Breakdown Structure diagram from your map. Diagram will be opened in ConceptDraw PRO. You can create single page or multiple page diagrams.

**Outline Documents**

- **MS Word** - Create a MS Word document from your map using embedded MS Word Template. Hyperlinks and Notes from your map will be converted to Hyperlinks and Comments in your MS Word document.
- **Project Outline** - Create a MS Word document from your map. Hyperlinks and Notes from your map will be converted to Hyperlinks and Comments in your MS Word document.
- **Two Weeks Checklist** - Creates a MS Word document which contains tasks which are scheduled for a two week period, starting with current week.
Project Management Reports

All Task Status Report - Generates a mind map that contains topics of the Task Type with completion icons and status symbols.

Completed Tasks - Generates a mind map that contains topics of Task Type that are Complete = 100%.

Unstarted Tasks - Generates a mind map that contains topics of Task Type that are Complete = 0% and Start Date < Today.

Overdue Tasks - Generates a mind map that contains topics of Task Type with Complete < 100% and Finish Date < Today.

Critical Tasks - Generates a mind map that contains topics of Task Type with Tasks that are behind schedule.

On Time Tasks - Generates a mind map that contains topics of Task Type that are on schedule.

Started Tasks - This mind map contains topics of Task Type with 0%<Complete < 100% and Start Date <= Today.

Tasks in Progress - This mind map contains topics of Task Type that are in progress.

Future Tasks - This mind map contains topics of Task Type with Complete =0% and Start Date > Today.

Today's Tasks - This mind map contains topics of Task Type which are scheduled for today.

Tomorrow's Tasks - This mind map contains topics of Task Type which are scheduled for tomorrow.

This Week's Tasks - This mind map contains topics of Task Type which are scheduled for the current week.

Next Week's Tasks - This mind map contains topics of Task Type which are scheduled for the next week.

Milestone Reports:

All Milestones - This mind map contains all topics of Milestone Type with completion icons and status symbols.

Completed Milestones - This mind map contains topics of Milestones Type with Complete = 100%.

Overdue Milestones - This mind map contains topics of Milestone Type with Complete < 100% and Finish Date < Today.

Future Milestones - This mind map contains topics of Milestone Type with Complete =0% and Start Date > Today.
MS Outlook tasks

All Task - Generates a mind map that contains topics of the Task Type with completion icons and status symbols.

Completed Tasks - Generates a mind map that contains topics of Task Type that are Complete = 100%.

Unstarted Tasks - Generates a mind map that contains topics of Task Type that are Complete = 0% and Start Date < Today.

Overdue Tasks - Generates a mind map that contains topics of Task Type with Complete < 100% and Finish Date < Today.

Critical Tasks - Generates a mind map that contains topics of Task Type with Tasks that are behind schedule.

OnTime Tasks - Generates a mind map that contains topics of Task Type that are on schedule.

Started Tasks - This mind map contains topics of Task Type with 0% < Complete < 100% and Start Date <= Today.

Tasks in Progress - This mind map contains topics of Task Type that are in progress.

Future Tasks - This mind map contains topics of Task Type with Complete = 0% and Start Date > Today.

Today's Tasks - This mind map contains topics of Task Type which are scheduled for today.

Tomorrow's Tasks - This mind map contains topics of Task Type which are scheduled for tomorrow.

This Week's Tasks - This mind map contains topics of Task Type which are scheduled for the current week.

Next Week's Tasks - This mind map contains topics of Task Type which are scheduled for the next week.

Milestone Reports:

All Milestones - This mind map contains all topics of Milestone Type with completion icons and status symbols.

Completed Milestones - This mind map contains topics of Milestone Type with Complete = 100%.

Overdue Milestones - This mind map contains topics of Milestone Type with Complete < 100% and Finish Date < Today.

Future Milestones - Milestones with Complete = 0% and Start Date > Today.
Dialogs

Map Theme Style
Color
Sort Topics
Options
Margins and Spacing
Properties
Export to Power Point
Export to MS Word
Export to Images
Export to RTF
Export to Text Outline
Export to Web page
Connect with Twitter Account
Note Exchange settings
Floating Panels
Symbols
Graphics
Hypernote
Topic Types
Topic Data
Page Navigator
Map Theme Style

Can be accessed from the Home tab. Open the Map Theme Style dialog to customize the visual representation of various types of topic's selection.

Focus, Selection, Overlap and Inner Highlight frames
Fill Color - Change the fill color of the frame.
Fill Transparency - Change the transparency of the frame.
Stroke Color - Change the outline color of the frame.
Stroke Weight - Change the weight of the outline of the frame.

Selection Rounded Rectangle
Left Margin - Set the left margin.
Right Margin - Set the right margin.
Top Margin - Set the top margin.
Bottom Margin - Set the bottom margin.
Round Radius - Set the radius of rounded corners
Use Left margin to define all margins - The settings of left margin will be applied to all margins.

Pictures
Expand Picture - Customize the Expand icon (+). Replace it with any picture from a file.
Collapse Picture - Customize the Collapse icon (-). Replace it with any picture from a file.
Color

Fill Color panel allows to set the fill style of topics, callouts and drawing shapes. Fill Color dialog is available on the Format tabs of the above elements. You can select a fill color, gradient type and a style of a pattern. Line Color panel allows to set the style of lines for topics, callouts, relationships and drawing shapes. Line Color dialog is available on the Format tabs of the above elements. You can select a color, weight and style for lines your mind map.

Colors dialog allows to set a background color. Also it can be use to set color for other mind map attributes. You can call this dialog by choosing the More Colors on the above color panels.

The Standard tab allows you to choose the needed color by clicking on it with the mouse. Using the Custom tab you can specify a color manually in one of the two available color schemes: RGB or CMYK. The currently chosen scheme is shown in the drop-down list:
- RGB Scheme
- CMYK Scheme

The R(ed), G(reen), B(lue) or C(yan), M(agenta), Y(ellow), (black)K slide bars allow to change each component of the color scheme. Note: In the RGB Scheme the color components may range from 0 to 255; in the CMYK Scheme the components are shown in percents and may range from 0 to 100. A slider allows you to add transparency to your objects in order to make them more attractive or if you want to see objects located under. Move slider to the right to increase the transparency of the object and to the left to decrease it.
To assist the user with selecting a font for an application, Microsoft Windows provides the Font dialog box. Use this dialog box to choose a font.

**Font**

Choose the name of the font. Use Control Panel to add and remove fonts from your system.

**Font style**: Choose the style of the font. Not all styles are available for all fonts.

**Size**: Choose the font size. You can specify smaller sizes than available in the list by typing the size in the edit field.

The **Effects** group box is equipped with a Strikeout check box, an Underline check box, and a Color combo box. To apply a style, click its check box. To remove a style just uncheck it. To select a color, click the arrow of the Color combo box and select a color.

The **Script** combo box allows you to specify an alphabetic category. The options are Western (the default for a US-English computer), Greek, Turkish, Central European, and Cyrillic.
Sort Topics

ConceptDraw MINDMAP allows you to sort topics on the map by specific criteria. The **Sort Topics** dialog is used for this.

![Sort Topics dialog](image)

**Sort by**
- Alphanumeric - Topics will be sorted in alphanumeric order.
- Alphabetic only - Lets you sort topics in alphabetical order only.
- Task percentage complete - Topics sorting according to the tasks percentage complete that is marked by symbols.
- Number - Topics will be sorted according to the numeric symbols, located on them.

**Sorting depth**
- Main Topics only - If this option is selected, only main topics will be sorted.
- Whole subtree - The sorting of the whole subtree.
- Until level - Lets you sort topics until some level, that you can choose or type a custom level.

**Sorting order**
- Forwards - Lets you sort topics forwards.
- Backwards - If this option is selected, topics will be sorted backwards.
Options

Can be accessed from the File tab. Contains options preferences related to the often used settings.

General
On Startup - Always start work with this operation:
- Create new document - Open the blank page
- Open last edited document - Open the last edited document
New Document - Choose the default way of your "blank page":
- Empty map - Create document from the empty mind map page, which only contains the Main Idea.
- From template - Create document from template.
Nickname - Display your Nickname at the Note panel.
Hide/Show Input and Output - Set the visibility of Input and Output panels
Save autoRecover info every ... minutes - On/Off the Auto saving in a fixed time interval.

View
Default View - Change how document content is displayed by default.
Map - Display Mind Map view.
Outline - Display Outline view.
Map&Outline - Display both: mind map and Outline views.
Fullscreen - Display document in the Full Screen mode.
Quick Symbols - Change the Symbols library used by default.
Color Scheme - Customize the workspace color.
Language - Change the interface language user by default.
Spelling
Dictionaries for spelling - Check the languages for spelling.
Check spelling as you type - Check the spelling and grammar as you type.
Edit custom dictionary - Adding the custom specific words to a custom dictionary prevents the spelling checker from flagging them as mistakes.

Format
Notes format - Specify the Notes formatting: set the font, size, attributes and the color of the Notes.
Map theme - Set the default map style.
Margins and Spacing

Can be accessed from the Layout section of Format Topic and Formal Callouts tab.

Allows to change Margins and Spacing settings

Margins
- Left Margin - Set the left margin.
- Right Margin - Set the right margin.
- Top Margin - Set the top margin.
- Bottom Margin - Set the bottom margin.
- Use Left margin to define all four margins - The settings of left margin will be applied to all margins.
- Padding - Set distance between the image that was inserted into the topic and topic's text.
- Preferred text width - Set the preferred width of the text within topic.

Spacing
- Distance from subtopics - Set the distance between selected topic and its subtopics
- Distance between subtopics - Set the distance between subtopics of the selected topic.
Properties

Can be accessed from the **File** tab. The Document Properties dialog allows you to configure some parameters that make working with the document more comfortable. It lets you set the following document properties: Title, Subject, Author, E-mail, Manager, Company, Comments.
Export to MS PowerPoint

You can export ConceptDraw MINDMAP documents to the Microsoft PowerPoint .pptx file format. Slides exported to .pptx format can be opened and used on previous versions of MS PowerPoint (.ppt), if you have downloaded the file format converter, available from Microsoft. Depending on the Export option selected, you can export your mind map as a text Outline or as Map images.

Export Slide Show

Export slide presentation for this map, using slides from Slide Navigator. If there are no slides in Slide Navigator, default presentation will be created from first-level topics and their subtopics.
Export Outline

Outline mode exports mind map content into a slide presentation based on the parameters selected.

Theme Map
Select a theme for your presentation from the list of themes preview, or by clicking Browse themes.... Once custom themes are applied, the last five themes used are retained for easy access.

Details
Click to manually select export parameters. The Export to PowerPoint window expands.
Export current page only - Export from the current displayed page
Export floating topics as appendices - Export all floating topics from your mind map as appendices on a separate slide in within your presentation
Export notes as PowerPoint notes - Export topic text notes from your mind map as PowerPoint notes for slides
Insert slide number - Insert slide numbers on each slide
Bulleted list - Export bulleted list
Numbered list - Export numbered list
Create separate slides for - Choose the number of topic levels for separate slides.
Depth level in slide content - Choose the number of subtopic levels presented on the master topic slide.

NOTE: For the example in Figure 1 and 2, the separate slides parameter is set to 1 level, and the slide content parameter is set to 2 level. The exported presentation contains a title slide and separate slides for the first level of map topics. Each generated slide has a topic name and list of associated subtopics up to two levels, as shown in the Figures 1 and 2.

Footer text -
The Footer text field enables you to enter text for inclusion in the slideshow
Export to MS Word

ConceptDraw MINDMAP offers several options of converting your mind maps to MS Word documents. Any mind map document can be converted to a MS Word structured document.

Using standard or custom templates, you will get ready to use formatted text. This method allows stylizing the resulting document by using a custom formatting.
Mind Map structure is transformed into the structure of the MS Word document in accordance with the MS Word Template styles.

<table>
<thead>
<tr>
<th>ConceptDraw MINDMAP</th>
<th>MS Word Template style</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Main Idea</td>
<td>Title</td>
</tr>
<tr>
<td>2 Main Topic</td>
<td>Heading 1</td>
</tr>
<tr>
<td>3 Subtopics of different levels</td>
<td>Heading 2 and higher (depending on the level)</td>
</tr>
<tr>
<td>4 Callout</td>
<td>Emphasis style paragraph, located below the topic</td>
</tr>
<tr>
<td>5 Text note</td>
<td>Normal style paragraph, located below the topic</td>
</tr>
<tr>
<td>6 Relationships between topics</td>
<td>Normal style paragraph contains reference to related topic</td>
</tr>
<tr>
<td>7 Hyperlink</td>
<td>Normal style paragraph contains hyperlink</td>
</tr>
</tbody>
</table>

Weekly Project Status Report

Summary for the week of September 9

Completed
- Finished initial dusting of west wing
- Removed furnishings from main ballroom
- Obtained permission to repair brickwork in east study
- Ordered new frames for windows facing east courtyard

Related Topics: Replace frames for windows facing east courtyard

- Replaced all fluorescent bulbs with energy efficient LEDs

To-Do
- Sweep and wax the all floor surface
- Refinish wood floors in main ballroom
- Go over revised budget with Alfred
- Replace frame, windows to main room standard
- Replace crumbling bricks in east
- Fix in east room fireplace broken and will need to be replaced
- Fix in east room fireplace broken and will need to be replaced
Export to Images

ConceptDraw MINDMAP allows you to save the whole map or its part in different graphic formats. This lets you illustrate your text documents with clear charts and schemes, and use ConceptDraw MINDMAP graphics in other applications.

In the Objects section, you can specify which objects will be exported in the graphic file.
- Selected - Export only the selected objects from the active page.
- All - Export all the objects on the current page if there is checked the option Current page only, or all the objects of all the document pages if option is unchecked.
- Slide show - Export Images Slides for this map, using slides from Slide Navigator.

If there are no slides in Slide Navigator, default Slide Show will be created for export from the first-level topics and their subtopics.

Image Size - In the Image Size section, you can choose one of the two options:
- Fit to Size - The image fits in the size specified by the user (in pixels). You can choose one of the offered variants from the drop-down list. The Screen variant allows to export the image which dimensions will be coincide with current screen dimensions.
- Lock aspect - When the one of the picture parameters was changed, the option Lock aspect ratio allows automatically change the value of the other parameter to lock the proportion accordingly the primary map dimensions.

Original Size - allows to export the image at its current zoom level. By default, the value of the export zoom coincide with zoom of the document. You can change this value into any desired.

Format

In the Format section you can choose one of the following graphic formats: BMP, JPG, GIF, TIFF or PNG. When choosing PNG format, you can check the Use Transparency option to obtain the fully transparent image background.

File name (Folder name)

The File name (Folder name) field lets you set the name of the exporting image or if you export more than one image, it's possible to open the image or the folder with images automatically after export. For this you need check accordingly the Show image after export or Open folder with images option.
You can save ConceptDraw MINDMAP file (cdmz) as MS Word Outline in a Rich Text Format (rtf).

Include Hyperlinks - Allows to include the existing links to the document.
Use Numeration - Allows to use the numeration of the pages in the document
Include Notes - Allows enabling pop-up prompts.
Export to Text Outline

ConceptDraw MINDMAP lets you save the currently opened mind map in textual form - as Outline Data. You can save ConceptDraw MINDMAP file (cdmz) as txt file type.

Use indents - This section lets you check whether to use indents in the list of topics. Indents display the structure of the map and show the hierarchy of topics. When this option is on, you can set the type of indents.

Tabulation - Displays topics' hierarchy by tabulation.

Space - Displays topics' hierarchy by spacing.

Include Hyperlinks - Shows the hyperlinks as a text.

Include Notes - Shows the Notes.

Use Numeration - Displays topics' hierarchy by numeration.
Export as Web page

Save the ConceptDraw MINDMAP cdmz file in html format as a mind map

Export Preview Bar - Show all pages preview at the Preview bar on the left of Web page.
Pages preview are linked to the corresponding pages.
Export Author - Insert the name author into Web document.
Export E-mail - Insert the link to email into Web document.
Zoom, (%) - change zoom of the map.
Choosing location button - Choose the location to save Web page.
Save the ConceptDraw MINDMAP cdmz file in html format as an outline

Include Symbols - Show Symbols
Include Notes - Show Notes
Include Topic Data - Show Topic Data
Include Hyperlinks - Show active hyperlinks
Include Text Formatting - Preserve the initial text formatting
Use Numeration - Export as numerated outline
Export Author - Insert the name author into Web document
Export E-mail - Insert the link to email into Web document
Choosing location button - Choose the location to save Web page

Weekly Project Status Report

Richard Miller  r.miller@csodessa.com

Completed
Finished initial dusting of west wing
Removed furnishings from main ballroom
Obtained permission to repair brickwork in east study
Ordered new frames for windows facing east courtyard
Replaced all fluorescent bulbs with energy efficient LEDs

Thanks for Jessica for providing a full dinner for the staff who volunteered to stay after hours to complete the bulb replacement

To-Do
Sweep and wax the all floor surface
Refinish wood floors in main ballroom
Go over revised budget with Alfred
Replace frames for windows facing east courtyard
Replace crumbling bricks in east study
Fix leak in east room fireplace broken and will need to be replaced

Order new solar panel to replace broken ones
Snow melt determined to originate somewhere in south wing; electrician to be called in

Repave entryway
Test structural integrity of south wing

Summary for the week of September 9

Back To Top
Connect with Twitter Account

ConceptDraw MINDMAP allows you to post topic content into your Twitter account. When posting your first Tweet from ConceptDraw MINDMAP you need to connect application with your Twitter account.

- Press "Sign In" at the context menu of Tweet Topic button
- Follow the steps, given in the dialog.
- Copy the PIN code, you have been provided on Twitter Authorization page.
- Press "OK".

![Twitter Account Connection Dialog](image-url)

![Twitter Account Grant Access](image-url)

![Twitter Account Authorization PIN](image-url)
Note Exchange Settings

Opens Note Exchange Solution Settings Dialog.

Manage connection between ConceptDraw MINDMAP and Evernote account using your the Evernote local client or your Evernote email address.

Choose the way you want to connect with Evernote:

- **Evernote application**
  
  This option allows for the one-click sending of map content to Evernote. **Evernote application** is required to be installed on your computer for this option.

- **E-mail client application**
  
  This option sends map content to your Evernote account via e-mail. You need to have an Evernote account and a desktop e-mail client (Outlook Express, MS Outlook, TheBat, Mozilla Thunderbird etc.) installed on your computer. Please paste your Evernote e-mail into the field below to use this option.

Username: 1234567@m.evernote.com

[Help] [OK] [Cancel]
Some tools and features in ConceptDraw MINDMAP are accessible from the floating panels. Floating panels can be accessed from the drop down list of the Panels button on the View tab.

**Floating Panels**
- Arrange
- Symbols
- Graphics
- Hypernote
- Topic Types
- Topic Data
- Page Navigator
**Arrange Panel**

The options for map arrangement. It is used to arrange topics, drawings, and images quickly.

You can activate the Arrange panel using the **Arrange** button on the **Home** tab;

The panel view differs for mind map topics and inserted objects.

The default arrangement of mind map topics is **Radial**.
To change the default arrangement of topics, you can select one of the following options:

More arrangement options keeping the ordinary structure of a mind map.

The Tree arrangement options can be used to visualize tree-like structures.
The Orgchart arrangement options allows you transform a mind map into organizational chart.

You can create a project timeline by starting with a mind map Timeline alignment.

Kanban arrangement option enables you to create mind map that can be effortlessly turned into Kanban board.
Arrangement panel contains some of the topic Position controls:

- Indent - Moves the topic to a lower level in the hierarchy.
- Outdent - Moves the topic to a higher level in the hierarchy.
- Move to Next Position - Moves the topic to the next position (based on the order the map is created).
- Move to Previous Position - Moves the topic to the previous position (based on the order the map is created).

Arrange panel for Drawing objects and pictures contains just the Ordering options. You can choose the order of the selected object you added into your mind map using the following options:

**Back**

**Front**
More ordering options for drawing objects:

**Backward**

![Backward Diagram]

**Forward**

![Forward Diagram]
Symbols Panel

Symbols are conventional signs used in Mind Mapping to mark the characteristics of the topic in visual form. The Symbols dialog allows to add, change or remove symbols in your map. There are three types of symbol's style available: Business, Modern and Classic. You can access them using the following methods:

- By clicking the Symbols button on the Insert tab;
- By selecting the Symbols panel from the drop-down list of the Panels button on the View tab;
- By pressing F9 on your keyboard;
- Using Context Menu.

Click on the Symbol to add it into selected topics. Also Drag&Drop can be used. The symbols of priority, emotions, progress of the tasks and numbers can be cyclically switched by clicking mouse cursor on them.

To remove symbol from the active topic, click the selected symbol again in the Symbols floating dialog. To remove all the symbols from the active topic, choose the Quick Symbols/Remove All item from the topic context menu.
Graphics Panel

Use the graphics floating panel to insert clip art objects and custom images into your mind maps. You can access the Graphics side panel using the following methods:

- By clicking the **Images from Graphics** button on the Insert tab;
- By selecting the Graphics panel from the drop-down list of the **Panels** button on the **View** tab;
- By clicking in the Graphics tab on the application's frame;
- Using **Context Menu**.

![Graphics Panel Screenshot](image-url)
Insert an Embedded Clip Art Image

In Graphics View tab you can choose objects from the drop-down list of pre-drawn objects. Clip Art objects cover various kinds of activities.

Only one group of the Clip Art objects at a time can be active. Under the active group is displayed its content. The objects in the Graphics window are displayed as pictures.

Insert a Picture from File

In Picture View you can open your own objects. It's possible to insert here any folder from your computer.

To do this click the Browse... button in the Graphics panel. The Browse For Folder dialog will appear. Choose the needed folder and click OK. The folder contents will appear. Further you can work with these pictures as well as with clip art objects supplied with program.

You can insert an image into your mind map by one of the following ways:
- By double-clicking the image preview on the Graphics panel;
- By drag & dropping them from the Graphics panel or from the File manager window to the document window;
- Copy and paste images using Keyboard Shortcuts: Ctrl+C and then Ctrl+V.
Hypernote Panel

Use this panel to create and manage both Text Notes and Hyperlinks. You can access the panel using the following ways:

- By clicking the Hypernote button on the Insert tab;
- By selecting the Hypernote panel from the drop-down list of the Panels button on the View tab;
- By clicking in the Hypernote tab on the application's frame;
- By pressing F11, or Ctrl + Shift + E on your keyboard;
- Using Context Menu.
The Note section of the Hypernote panel displays the Note content for the currently selected topic. Enter here the text of your Note. You can change the appearance of Note text by selecting options in the Format panel.

To delete a Note, select the topic and choose the Note / Remove item from the topic context menu.

The Note holds additional remarks concerning the topic. It is indicated by a Note icon on the topic. The Note appears as a tool tip when you point to the Note icon with the mouse.

At the adding the Note to the topic, the icon will appear. You can sign your notes with Nickname using the Options dialog.

Use the Hyperlink section for assigning and editing hyperlinks.

You can assign the following types of links:

- **Link to URL** - allows to assign the link on the Web page;
- **Link to Topic** - lets you assign the link on any document page or topic. To assign the link, choose the corresponding page or topic.
- **Link to File** and **Link to Folder** - allow assign the link accordingly to any file on the disk or to a folder with files. You can enter in the text field or choose in browser the path to the file or folder, and also check will be this path Relative or Absolute. Click the icon to select the path type.

  - **Absolute**
  - **Relative**

  By default, the path is set as relative, i.e. if you, for example, will assign the link to any document and then will move the map and this document to another place of the disk, for keeping the link correct you need change its path. In the case of the absolute address the link will stay correct.

- **Link to E-mail** - allows to assign the link, which opening will automatically create message with set address. You can enter the address in the field or choose it from the drop-down list of recently used e-mail addresses.

You can remove the selected link using the button.
Topic Types Panel

Use the Topic Types floating dialog for assigning and editing the topic type. You can access the panel using the following ways:

- By clicking the Topic Types button on the Insert tab;
- By selecting the Topic Types panel from the drop-down list of the Panels button on the View tab;
- By clicking in the Topic Types tab on the application’s frame;
- Using Context Menu.

Each topic type supports the certain topic data - the set of information concerning to topic’s content. For example the topic of Task type can contain such information as Start date, Due date, Duration, Complete percentage, Task priority etc.

The number of topic types that you can use is determined by default topics types, which are supplied with application and plug-ins that you can additionally install on your computer.
To assign topic type to selected topic follow these steps:
1. Open Topic Type Dialog;
2. Choose Activity from drop-down list of activities;
3. Click on the Topic Type you need to assign.
Topic Data Panel

Use the Topic Data floating panel for assigning and editing the topic data. Each topic type supports the certain set of information concerning to topic’s content.

To set data for selected topic follow these steps:
1. Assign Type to topic.
2. Open Topic Data panel;

You can access the panel using the following ways:
- By clicking the Topic Data button on the Insert tab;
- By selecting the Topic Data panel from the drop-down list of the Panels button on the View tab;
- By clicking in the Topic Data tab on the application's frame;
- Using Context Menu.
Each Topic Type supports a specific set of Topic Data information relating to the contents of the topic. For example, the Task topic type can contain such topic data as start date, due date, duration, percentage complete, task priority, etc.

Another kind of Topic Data provides the possibility to attach and manage documents.
Page Navigator Panel

Provides the possibility to operate with pages in a current document. You can access the Page Navigator side panel using the following methods:

- By clicking the Page Navigator button on the View tab;
- By selecting the Page Navigator panel from the drop-down list of the Panels button on the View tab;
- By clicking in the Page Navigator tab on the application’s frame.

You can manage pages using context menu of the Page Navigator.

- Add a blank page into a current document;
- Rename selected page;
- Duplicate the selected page;
- Delete the selected page;
- Reposition pages moving them left or right.
Context Menu

ConceptDraw MINDMAP enables access the most frequently used operations with objects via the context menu. There are different types of context menu related to different pieces selected. The figure below displays all the types of context menus. However, actually, you can see only one menu - depending on the selected item.

1. Main Idea Context Menu.
2. Topic Context Menu
3. Callout Context Menu
4. Relationship Context Menu
5. Drawing Shape Context Menu
Main Idea Context Menu

Copy - Copy the selection to clipboard;
Paste - paste from clipboard;
Insert - insert one of the following items:

- Topic
- Callout
- Relationship
- Attach File

Format - open Format Topic tab;
Arrange Branch - Arrange mind map;
Hyperlink - operate with hyperlinks using the Hypernote panel;
Text Note - operate with hyperlinks using the Hypernote panel;
Topic Data - activate the Topic Data panel
Topic Type - assign one of the available topic types:

- Appointment
- Email
- Human Resource
- Material Resource
- Milestone
- Phase
- Project
- Project Group
- Project Idea
- Requirements Document
- Specification Document
- Task

Picture - Add or remove images;
Quick Symbols - add or remove symbols;
Send to Evernote - share mind map content via Evernote;
Send to MS OneNote - share mind map content via MS OneNote;
Send to MS Outlook - share mind map content via MS Outlook;
Levels - select the depth of mind map view:

Create Slide - Create presentation slides using the following options:

- With Subtopics
- By Selected
Topic Context Menu

- Cut - cut the selection from the document and put it on the Clipboard;
- Copy - Copy the selection to Clipboard;
- Paste - paste from clipboard;
- Delete - delete the selection;
- Detach - You can detach any topic in your mind map to make it a floating topic;
- Insert - insert one of the following items:
  - Topic
  - Callout
  - Relationship
  - Attach File

- Format - open Format Topic tab;
- Arrange Branch - Arrange selected branch of mind map;
- Hyperlink - operate with hyperlinks using the Hypernote panel;
- Text Note - operate with hyperlinks using the Hypernote panel;
- Topic Data - activate the Topic Data panel;
- Topic Type - assign one of the available topic types:
  - Appointment
  - Email
  - Human Resource
  - Material Resource
  - Milestone
  - Phase
  - Project
  - Project Group
  - Project Idea
  - Requirements Document
  - Specification Document
  - Task

- Picture - Add or remove images;
- Quick Symbols - add or remove symbols;
- Send to New Page - All topics that have been selected will be moved, along with their subtopics, to a separate page;
- Send to Evernote - share mind map content via Evernote;
- Send to MS OneNote - share mind map content via MS OneNote;
- Send to MS Outlook - share mind map content via MS Outlook;
- Create Slide - Create presentation slides using the following options:
  - With Subtopics
  - By Selected
Callout Context Menu

Cut - cut the selection from the document and put it on the Clipboard;
Copy - Copy the selection to Clipboard;
Paste - paste from clipboard;
Delete - delete the selection;
Format - open Format Callouts tab;
Hyperlink - operate with hyperlinks using the Hypernote panel;
Text Note - operate with hyperlinks using the Hypernote panel;
Picture - Add or remove images;
Quick Symbols - add or remove symbols;
Send to Evernote - share mind map content via Evernote;
Create Slide - Create presentation slides using the following options:

- With Subtopics
- By Selected
Relationship Context Menu

- **Delete**: delete the selection;
- **Format**: open Format Relationships tab;
- **Relation Type**: change the type of the selected relationship;
- **Order**: change the relationship order;
- **Create Slide**: Create presentation slides using the following options:
  - With Subtopics
  - By Selected
Drawing Shape Context Menu

Cut - cut the selection from the document and put it on the Clipboard;
Copy - Copy the selection to Clipboard;
Paste - paste from clipboard;
Delete - delete the selection;
Format - open Format Drawing tab;
Order - change the drawing shape order;
Create Slide - Create presentation slides using the following options:
   - With Subtopics
   - By Selected
# Keyboard Shortcuts and Mouse Actions

## Documents and Windows

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Alt + N</td>
<td>Invoke Startup Dialog</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Create a New Document</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open a Document</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save the active document</td>
</tr>
<tr>
<td>Ctrl + Shift + S</td>
<td>&quot;Save as &quot; the active document</td>
</tr>
<tr>
<td>Ctrl + Alt + S</td>
<td>Save the document as Template</td>
</tr>
<tr>
<td>Ctrl + Alt + I</td>
<td>Input View</td>
</tr>
<tr>
<td>Ctrl + Alt + O</td>
<td>Output View</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Ctrl + Shift + P</td>
<td>Quick Print</td>
</tr>
<tr>
<td>F7</td>
<td>Spelling</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Close the active window</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>Close the active document</td>
</tr>
<tr>
<td>Ctrl + F4</td>
<td></td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>Activate the next window</td>
</tr>
<tr>
<td>Ctrl + F6</td>
<td></td>
</tr>
<tr>
<td>Ctrl + Q</td>
<td>Quit ConceptDraw MINDMAP</td>
</tr>
</tbody>
</table>

## Document View

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift + F3</td>
<td>Outline and map views</td>
</tr>
<tr>
<td>F3</td>
<td>Map view only / Outline view only</td>
</tr>
<tr>
<td>F5</td>
<td>Start Presentation Mode</td>
</tr>
<tr>
<td>Shift+F5</td>
<td>Full Screen Mode</td>
</tr>
<tr>
<td>F6</td>
<td>Show / Hide Page Navigator</td>
</tr>
<tr>
<td>Shift+F6</td>
<td>Show/Hide Slide Navigator</td>
</tr>
<tr>
<td>Ctrl + 0</td>
<td>Show fit map</td>
</tr>
<tr>
<td>Ctrl + &quot;=&quot;</td>
<td>Zoom In</td>
</tr>
<tr>
<td>Click in Zoom Box mode</td>
<td>Zoom In / Zoom Out</td>
</tr>
<tr>
<td>Ctrl + mouse wheel</td>
<td></td>
</tr>
<tr>
<td>Ctrl + Shift + Z</td>
<td>Select/ Deselect zoom box tool</td>
</tr>
<tr>
<td>Ctrl + &quot;+&quot;</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Click + Alt/ Ctrl /Shift in Zoom Box mode</td>
<td>Show / Hide levels</td>
</tr>
<tr>
<td>Alt+ Enter</td>
<td></td>
</tr>
<tr>
<td>Shift + mouse wheel</td>
<td>Horizontal scroll</td>
</tr>
<tr>
<td>Click in Print Preview</td>
<td>Change zoom level (in cycle)</td>
</tr>
<tr>
<td>PgUp</td>
<td>Go to the previous page</td>
</tr>
<tr>
<td>PgDn</td>
<td>Go to the next page</td>
</tr>
<tr>
<td>Shift + PgUp</td>
<td>Scroll one window space up</td>
</tr>
<tr>
<td>Shift + PgDn</td>
<td>Scroll one window space down</td>
</tr>
<tr>
<td>Ctrl + Shift + 0</td>
<td>Show fit selection</td>
</tr>
</tbody>
</table>
Selecting Objects

- Select with Shift/Ctrl: Allows to select several objects
- Ctrl + A: Select all the objects on page
- Tab: Select the next object according to the order of their creation
- Shift + Tab: Select the previous object

Editing

- Ctrl + Z: Undo the last operation
- Alt + Backspace: Redo what was reversed by Undo
- Ctrl + Y: Cut the selection to the Clipboard
- Ctrl + X: Copy the selection to the Clipboard
- Ctrl + C: Paste the content from Clipboard
- Shift + Ins: Delete the selected object(s)
- Backspace: Search/Replace Text
- Ctrl + F: Duplicate the selected object(s)
- Ctrl when dragging: Cancel the operation
- Esc when resizing or dragging the object

Dialogs

- F4: Show/Hide Clipart floating dialog
- F9: Show/Hide Symbols floating dialog
- F10: Show/Hide Topic Data floating dialog
- Ctrl + Shift + T: Show/Hide Map Themes Attributes dialog
- Shift + F10: Show/Hide Topic Types floating dialog

Topics

- Enter: Add a topic at the same level
- Double-click: Add a subtopic to the selected topic
- Ctrl + Enter: Insert
- Insert: Shift + Double-click
- Ctr + Shift + L: Add callout to selected topic
- Ctrl + Right: Indent topic (one level deeper)
- Ctrl + Left: Outdent item (one level closer to the root)
- Ctrl + Down: Move item to the next position (one line down)
- Ctrl + Up: Move item to the previous position (one line up)
- Backspace: Delete the selected topic(s)
## Keyboard Shortcuts and Mouse Actions

### Del / Delete
- **Arrows** Select the next topic
- **Ctrl + Double-click** Add floating topic
- **Double-click** Add a new topic to the main idea (if no topic is selected)

### Alt + Enter
- **Shift + Space** Expand/Collapse Topic Levels
- **Ctrl + Shift + A** Add a new topic to the main idea (if no topic is selected)

### Ctrl + Enter
- **Ctrl + Enter editing mode** Quit editing mode and insert subtopic
- **Ctrl + Enter editing mode** Quit editing mode with no changes

### Ctrl + Enter editing mode
- **Shift + Enter** Start a new text line in the text editing mode
- **Enter** Quit editing mode and insert topic

### Ctrl + Alt + B
- **Ctrl + Alt + B** Hold Brainstorming session
- **Enter** Insert new idea as floating topic
- **Alt + F4** Quit Brainstorming session

### Ctrl + Shift + " [ "
- **Ctrl + Shift + " [ "** Send to Back
- **Ctrl + Shift + " ] "** Bring to Front
- **Ctrl + " [ "** Send Backward
- **Ctrl + " ] "** Bring Forward

### Ctrl + "
- **Resize with Shift** Toggle between proportional and non-symmetrical resizing

### Ctrl + 1
- **Activate Select tool**
- **Activate Rectangle tool**
- **Activate Ellipse tool**
- **Activate Line tool**
- **Activate Spline tool**
- **Activate Text Editing mode**
- **Activate Scroll Hand tool**
- **Constrained drawing mode (circle, square)**

### Text Formatting
### Keyboard Shortcuts and Mouse Actions

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + D</td>
<td>Format Text</td>
</tr>
<tr>
<td>Ctrl + B</td>
<td>Bold</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Italic</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Underline</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Align on the left</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Align in the center</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Align on the right</td>
</tr>
<tr>
<td>Ctrl + &quot;.&quot;</td>
<td>Increase font</td>
</tr>
<tr>
<td>Ctrl + &quot;,&quot;</td>
<td>Decrease font</td>
</tr>
<tr>
<td>Ctrl+Shift+C</td>
<td>Copy formatting from selection</td>
</tr>
<tr>
<td>Ctrl+Shift+V</td>
<td>Apply copied formatting</td>
</tr>
</tbody>
</table>

**Application**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Call Help System</td>
</tr>
<tr>
<td>Ctrl+F1</td>
<td>On/ Off the Ribbon minimizing</td>
</tr>
<tr>
<td>Ctrl + &quot;*&quot;</td>
<td>Options (Application Settings)</td>
</tr>
</tbody>
</table>

**Office tools**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + J</td>
<td>Open in Project</td>
</tr>
<tr>
<td>Ctrl + Shift + J</td>
<td>Create Project from the current page</td>
</tr>
</tbody>
</table>

**Presentation mode**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Go to the next slide</td>
</tr>
<tr>
<td>Arrows (left/right)</td>
<td>Go to the next / previous slide</td>
</tr>
<tr>
<td>B</td>
<td>Darken</td>
</tr>
<tr>
<td>W</td>
<td>Lighten</td>
</tr>
<tr>
<td>Backspace</td>
<td>Go to the previous slide</td>
</tr>
<tr>
<td>Esc</td>
<td>Exit from presentation mode</td>
</tr>
</tbody>
</table>

**Slide Navigator**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Insert new slide</td>
</tr>
<tr>
<td>Arrows (left/right)</td>
<td>Go to the next / previous slide</td>
</tr>
<tr>
<td>Ctrl + Arrows(left/right)</td>
<td>Move slide left / right</td>
</tr>
<tr>
<td>Delete/ Backspace</td>
<td>Remove slide</td>
</tr>
<tr>
<td>Esc</td>
<td>Move focus to map</td>
</tr>
<tr>
<td>Enter</td>
<td>Focus moves to the map</td>
</tr>
<tr>
<td>Home / End</td>
<td>Go to the first or last slide</td>
</tr>
<tr>
<td>F2</td>
<td>Start /End editing the slide title</td>
</tr>
<tr>
<td>Ctrl + Shift + 1</td>
<td>Create slide from visible objects</td>
</tr>
<tr>
<td>Ctrl + Shift + 2</td>
<td>Create slide from selection</td>
</tr>
<tr>
<td>Ctrl + Shift + 3</td>
<td>Create slide from selection with subtopics</td>
</tr>
<tr>
<td>Ctrl + Shift + R</td>
<td>Refresh previews</td>
</tr>
<tr>
<td>Ctrl + F5</td>
<td>Start presentation from the selected slide or start default presentation if no slides created.</td>
</tr>
</tbody>
</table>

**Page Navigator**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click on empty place</td>
<td>Add New Page</td>
</tr>
<tr>
<td>Ctrl+Shift + N</td>
<td>Start editing the page title</td>
</tr>
<tr>
<td>Click mouse</td>
<td></td>
</tr>
<tr>
<td>F2</td>
<td>Start /End editing the page title</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Move page to the left / to the right</td>
<td>Ctrl + Arrows (left/right)</td>
</tr>
<tr>
<td>Go to the next / previous page</td>
<td>Arrows (left/right)</td>
</tr>
</tbody>
</table>